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Extreme Editing Workflow 

In a recent lesson, we talked 
about how to create dramatic 
black and white images of ar-
chitecture. In this lesson, we’re 
going to take that same image 
we worked on previously and 
look at different ways that we 
could achieve the same end re-
sult, using more versatile ways 
of working. Note that many of 
the techniques will still be use-
ful even if you don’t plan on 
working in black and white or 
with architectural images. 

In the previous lesson, we created two layers that contained two versions of the 
image. The bottom layer contained a dark version of the image and the top layer 
contained a bright version of the image. We added a layer mask to the top layer, al-
lowing the brightness to show up only in certain areas. What makes this technique 
less than ideal is that all of the various areas are being brightened by a single layer 
mask. This makes it difficult to go back and fix or adjust individual areas. 

In this lesson, we will create the same effect but create a more complex document 
in doing so. This will allow us to have more control as well as the ability to change 
individual areas later. 

There are a few different concepts that you will need to understand before we can 
truly start to work on the image so we will look at those first.

This is the dramatic black & white effect we’re going to 
recreate in this lesson using many advanced techniques.
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Create Two Versions of the Image

When we create this black and white effect, we will start with the same two layers 
that we did in the previous lesson. These layers contain two versions of the same 
image. One version will be dark and dull-looking. The other version will be so bright 
that it’s close to losing detail. After we create these two versions, we’ll use several 
techniques to incorporate the two together. We talked about how to create these 
two layers in the previous video lesson, so Ben does not cover that process in this 
video. I am including the steps below so that you have a good starting point in this 
handbook.   

Create the dark, dull version We’ll create the dark and 
dull version of the image first. We’ll open the image as a 
smart object in Photoshop. If you are using Lightroom, 
you will select the image, click on the Photo menu and 
choose Edit in > Open as Smart Object in Photoshop. If 
you are using Adobe Camera Raw, you will hold down 
the Shift key so that the “Open Image” button (in the 
lower right) turns into the “Open Object” button and 
then click that button.  

In Photoshop, we’ll double-click on the thumbnail for the image layer. This will open 
the smart object to show its contents in a separate window. Because the contents 
of this smart object is a raw file, it’s going to open the image in Camera Raw. 

The first thing we’ll do here is convert the image to black and white by turning on 
the Black & White check box that appears at the top of the Basic Panel, on the right 
side of the interface. Next, we’ll use the Basic Panel sliders to darken the image. We 
don’t want it to look so dark that we can’t see any detail, but it should look dark 
and dull. In the video example, the Exposure slider was set to around -2 and the 
Highlights slider was moved almost all the way to the left. This caused some areas 
to become so dark that they lost detail, so we moved the Shadows slider up until 
some of that detail returned. We also want the image to look dull, so we moved the 
Contrast slider far to the left as well. 

You can tell a layer is a smart 
object because it will have 
the icon in the bottom right 
corner of the thumbnail.
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We’ll click OK to exit Camera Raw and return to Photoshop’s main interface. The 
image will be updated here and this will be the base image that we’re going to 
build on. 

Create the bright version Now we’re going to create a second ver-
sion of the image. This version will be extremely bright. We will duplicate the orig-
inal smart object, but we need to do so in a special way. If we were to simply du-
plicate the layer by using the standard method (Command+J, Ctrl+J on Win), we 
would be creating a second instance of the SAME smart object. If we were to make 
a change to one instance of the smart object, all other instances of that same smart 
object would be changed as well. We DON’T want that. 

We need to create a duplicate of the smart object that is independent of the orig-
inal. We can do this by clicking on the Layer menu and choosing Smart Objects > 
New Smart Object Via Copy. We now have two smart object layers in the Layers 
Panel. We’ll rename the bottom layer to “Dark” and the top layer to “Bright.” 

The smart 
object was 
opened in 
Camera Raw 
and we are 
using the Basic 
Panel sliders to 
create the dark 
version of the 
image. 
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We need to adjust the “Bright” layer to make it really bright and really pop. We’ll 
double-click on the image thumbnail in the Layers Panel. This will open the con-
tents of the Smart Object and, since it’s a raw file, it will again open the image into 
Camera Raw. Here, we’ll use the sliders in the Basic Panel on the right side of the 
screen. 

We’ll move the Exposure, Shadows and Whites sliders to the right, brightening the 
image. The image should be extremely bright, but not so bright that it’s losing de-
tail. If it starts to lose detail, er can always move the Highlights slider down a bit to 
compensate. We’ll also move the Texture and Clarity sliders to the right a bit, mak-
ing the details pop out more. After making these adjustments, we’ll click on the OK 
button to exit Camera Raw and return to Photoshop’s main interface. 

The dark layer is on the bottom and the bright layer is on the top. 

LEFT: The second 
smart object was 
opened in Camera 
Raw. In this version, 
we are brightening 
the image and mak-
ing the details pop.

ABOVE: We have 
two versions of the 
image: a dark version 
and a bright version.
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Layer masks & vector masks (Timestamp 6:15)

One of the things you’ll need to 
understand is the difference be-
tween layer masks and vector 
masks. If you click the Layer Mask 
icon at the bottom of the Layers 
Panel, a layer mask will be added 
to the active layer. If you click that 
Layer Mask icon a second time, it 
will look as if a second layer mask 
is added. That’s not the case. That 
second mask is actually a vector mask. A vector mask will limit where an area ap-
pears by using a path. A path can be created by using the Pen Tool or the Shape 
Tool. For this technique, we will use both a vector mask and a layer mask in order 
to be more versatile. 

After clicking the Layer Mask icon twice to add the two masks, both of these masks 
will be active by default. You can tell that a mask (or a layer) is active because it 
will have little white brackets around its thumbnail. At this point, if you were to use 
any type of brush tool, it would affect the layer mask (not the vector mask). That’s 
because a brush will add or remove pixels and a layer mask is considered to be a 
pixel-based mask. If you instead used the type of tool that would create a path (Ex: 
the Pen Tool), then you would be affecting the vector mask and not the layer mask. 
To clarify, you can have both masks active at the same time and the type of tool 
you use will determine which mask is affected. 

In order to create the dramatic black and white effect, we are going to follow a dif-
ferent process from the one we used in the other lesson, but we will still start with 
the same initial two layers: The bright layer and the dark layer. Before we truly start 
to work on the image, let’s look at how we’re going to use layer masks and vector 
masks with these two layers. 

With the bright layer active, we’ll click the Layer Mask icon once to add a layer 
mask and then we’ll click it a second time to add a vector mask.

This layer has both a layer mask and a vector mask. 
You can tell that both masks are active because they 
are surrounded by white brackets.  
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Working on the vector mask When we start to 
create the effect, we’re going to focus on one 
part of the building at a time, and we’ll start with 
one of the large panels on the left side. We’ll 
activate the Pen Tool and we’ll make sure that 
the menu in the Options Bar is set to create a 
Path. We’ll also make sure that the vector mask 
thumbnail has white brackets around it, indicat-
ing that it is active. We’ll use the Pen Tool to iso-
late the panel. We’ll start by clicking on one of 
the corners to add a point. After we place the 
second point, the entire bright layer will become 
hidden. That’s because a vector mask will only 
reveal the layer you’re currently working on in-
side the shape of the path that you’ve drawn. 
After we start to add more points, the bright 
layer will start to appear inside the shape that 
we’re drawing. As we’re finishing making the 
shape, we’ll make sure that we click where we 
started in order to close the path. 

Working on the layer mask Now we have a vec-
tor mask limiting where the bright layer is visible 
in the image. We’re going to add to this by ap-
plying the Gradient Tool. The Gradient Tool cre-
ates pixels (not paths) so it’s going to affect the 
layer mask and not the vector mask. We’ll make 
sure that the layer mask has little white brackets 
around it, indicating that it is active. Then we’ll 
activate the Gradient Tool, we’ll make sure that 
it is set to the “foreground to background” gra-
dient and we’ll ensure that the foreground color 
is white and the background color is black. 

When using the Pen Tool on a vector 
mask, we need to make sure that the 
menu in the Options Bar is set to  
create a Path.

The Pen Tool is being used to create a 
path around one of the panels on the 
building.



Extreme Editing Workflow © Ben Willmore, All rights reserved 8

We’ll use the Gradient Tool to click on the right side of the building panel and drag 
to the left, about half-way into the panel. When we release the mouse button, the 
white-to-black gradient will be applied. Because this gradient is being applied to 
the layer mask, the white parts are where the layer is being revealed and the black 
parts are where the layer is being hidden. The black part of the gradient on the left 
side of the panel will hide the bright layer. 

We now have two masks limiting where the bright layer can be visible. The vector 
mask is hiding the entire layer except for the targeted panel on the building and the 
layer mask is creating the fade-out effect in that panel. This gives us added versa-
tility that we didn’t have when creating this effect in the other lesson. 

LEFT: The Gradient Tool is being used to drag right to left over the targeted building panel. 
RIGHT: When the mouse button is release, the gradient is applied to the layer mask. 

Both the layer mask and the vector 
mask are limiting where the Bright 
layer is visible. The vector mask is 
isolating the panel and the layer 
mask is creating the gradient on 
the panel.
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Feather the vector mask The last time we 
created this black and white effect, we iso-
lated areas by using the Polygonal Lasso Tool 
and then we used the Feather command to 
soften the selection edges. With the tech-
nique in THIS lesson, we used the Pen Tool on 
a vector mask instead of the Lasso Tool, but 
we can still soften the edges. We’ll make sure 
the Properties Panel is visible on the screen. 
If it’s not already open, you can access it by 
clicking on the Window menu and choosing 
Properties. Two icons will appear at the top of 
the Properties Panel. If the icon on the left is 
active, it will work on the contents of the layer 
itself (the actual pixels). If the icon on the right 
is selected, it will instead work on the masks 
that are attached to the layer. If this mask icon 
is turned on and you have two types of masks 
attached to the layer, two additional icons will 
appear, allowing you to determine whether 
you will be working with the layer mask or the 
vector mask. If the left icon is selected, the 
panel will present settings for the layer mask. 
If the right icon is selected, the panel will pres-
ent settings for the vector mask. 

We’ll make sure the vector mask icon is selected. Below that, there is a Feather 
slider and moving this slider up is the equivalent to feathering an active selection. 
What’s great about this setting is that we can go back and change it at any time, 
adjusting the feather setting on the mask. This is not something that we could do 
with the technique from the previous lesson. 

In the Properties Panel, we selected  
the icons (circled) to work on the  
vector mask. Here, we are increasing 
the Feather slider very slightly in  
order to soften the edge of the mask.
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Making changes to the vector mask If you 
find any problems with the vector mask, it is 
easy to go back and fix them at any time. In 
the video example, the mask stopped short 
of the top of the building panel, so we need 
to extend it upward just a bit. The path used 
to create the vector mask is not currently 
visible in the image window and that’s because we’re not currently using a tool 
that can edit the vector mask. If we were in the Shape Tool, the Pen Tool, the Path 
Selection Tool, or the Direct Selection Tool, the path would appear. The Path Selec-
tion Tool allows us to work on the path shape as a whole and the Direct Selection 
Tool will allow us to work on individual points on the path. 

We’ll activate the Direct Selection Tool, which 
looks like a white arrow and is grouped with 
the Path Selection Tool in the Toolbar. With 
this tool, we can click on a point and drag 
it around to reposition it. Alternatively, we 
could click on a point to make it active and 
then use the arrow keys on the keyboard to 
move the point around with more precision. 
We’ll click on one of the points at the top 
of the building panel and then use the arrow keys to make sure the path perfectly 
aligns with the panel. Then we’ll do the same thing for the other top point. If the 
path lines make it hard to tell when things are aligned, you can use temporarily hide 
them by using the keyboard shortcut Command+H (Ctrl+H on Win). 

When modifying a path, you may need to 
add a point and you can do that with the 
Pen Tool. With the Pen Tool active, hover the 
cursor over the curve line and you will see a 
little plus icon ( + ) appear. This means that 
by clicking on the path line, you will be add-
ing a point. 

The Direct Selection Tool is grouped 
with the Path Selection Tool. 

The Direct Selection Tool is being used 
to fine-tune the position of a point on 
the path. 

The Pen Tool is 
being used to 
add a point to 
the path.
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If the point has little handles coming out of it and you do not need a curved line, 
you can hold down the Option key (Alt on Win) and then click on the point to re-
tract the handles. With the Pen Tool, you can also remove a curve point simply by 
clicking on it. 

Make Changes to the Layer Mask Let’s say that we want to reposition the gradient 
that’s contained in the layer mask so that it extends farther across the panel. We 
could use the Gradient Tool to create a new gradient, or we could instead reposi-
tion the gradient using the Move Tool. We’ll activate the Move Tool so that we can 
reposition the gradient, but we need to be careful when doing this. By default, us-
ing the Move Tool will reposition the entire layer, along with the layer mask. That’s 
because the layer mask is linked to the layer, and you can see the little link icon 
between the layer thumbnail and the mask thumbnail in the Layers Panel. 

We want to move the layer mask but keep the actual layer in place, so we’ll click 
the little link icon in order to make it disappear. Now we can activate the layer mask 
and use the Move Tool to reposition it. Because the mask is unlinked, the image 
layer will stay in place. It’s only the mask that will move.

If the bright areas that we’re introducing to the image are too bright, we can lower 
the opacity of the entire layer by using the Opacity setting at the top of the Layers 
Panel. 

We now know how to use a vector mask and a layer mask to reveal the bright layer 
on one of the building panels. To truly finish this image, we’ll need to lighten addi-
tional areas in the rest of the image, but we can not use those same masks to do 
so. We will need to look at additional concepts before we can complete the effect 
on this image. 

LEFT: The layer mask is linked to the layer. If we move the mask, the image layer will move 
along with it. RIGHT: We clicked the link icon to unlink the mask from the layer. Now we can 
move the mask and the image layer will stay in place. 
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Using an “Empty” Adjustment Layer with Knockout Shallow (22:04)

Before we truly start working on the image, you must be introduced to two more 
concepts. One of these is an “empty” adjustment layer and the other is the Knock-
out setting in the Layer Style dialog. To understand these concepts, we’ll again 
start with our initial two layers: the layer containing the dark version of the image 
(on the bottom) and the layer containing the bright version of the image (on the 
top).

One of the things we’re going to use is an empty adjustment layer. An empty ad-
justment layer is one that doesn’t actually change the look of the picture. For ex-
ample, we could create a Levels adjustment layer but never change the settings 
relating to that adjustment layer. The same could be done with a Curves adjust-
ment layer, Hue/Saturation, Color Balance, etc. With all of these adjustments, we 
could leave them at their default settings and the image will not be changed at all. 
We could not create an empty adjustment layer using the Invert adjustment layer 
or the Black & White adjustment layer. These types of adjustments will change the 
image as soon as we create them. 

We’ll create a Brightness/Contrast adjustment layer and we’ll leave the settings 
alone so that it doesn’t change the look of the image at all. (We just randomly 
chose the Brightness/Contrast adjustment, but we could have chosen any of those 
adjustments that make no initial changes to the image.)  

Even though the adjustment is not doing anything, Photoshop thinks that the ad-
justment layer contains what the picture would visually look like as a result of that 
adjustment. Because the adjustment is not changing anything, Photoshop thinks 
that the contents of the layer is like a copy of whatever the picture looks like. If 
there is a layer mask attached to the adjustment layer, it will think that the copy 
only takes up the amount of space that is revealed by the mask. 

To give you an idea of how Photoshop thinks about this layer, we could change the 
blending mode of this empty adjustment layer and it will change the look of the 
picture, acting as if the adjustment layer is a duplicate of the underlying image. 
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We’re going to use this adjustment layer to poke a hole through the layer that’s 
underneath it (the bright version of the image) to reveal the bottom layer (the dark 
version of the image). In order to do that, we’re going to need to get a little fancy. 
We need to select the empty adjustment layer and the layer we want to poke a 
hole in, and then place these two layers into a group by clicking on the folder icon 
at the bottom of the Layers Panel. We’ll expand the group/folder and select the 
adjustment layer. Then we’ll click on the FX icon at the bottom of the Layers Panel 
and choose “Blending Options” from the pop-up menu. The Layer Style dialog will 
appear and the Blending Options settings will be visible. We need to focus on the 
Knockout menu, located near the center of this dialog. This menu includes the op-
tions of None (the default setting), Shallow and Deep. If we were to set this menu 
to Deep, it would knock through every single layer (that’s below the active layer) 
until it hits a layer called “Background.” In our current document, there is no Back-
ground layer, so this setting would knock through everything, creating a hole in the 
image. If we set the Knockout menu to Shallow, it will knock through all of the lay-
ers (beneath the active layer) that are contained in the same group. In our case, the 
bright version of the image is the only other layer in the same group, so it will poke 
a hole through this layer to reveal the dark version of the image underneath. We’ll 
set the menu to Shallow and then click the OK button to exit the Layer Style dialog. 

The Knockout setting can be found within the Blending Options category of the Layer Style 
dialog.
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Combining Concepts to Create the Black & White Effect (29:18)

Up until this point, we learned about the following concepts:

• Layer masks vs. vector masks

• Adjusting a vector mask

• Adjusting a layer mask

• How to use an empty adjustment layer 

• The Knockout setting 

We’re going to use all of these concepts together in order to create the dramatic 
black and white effect. 

SET UP THE LAYERS 

We’ll start by setting up the layers, but the stacking order is going to be a little 
different. When we demonstrated the vector mask concept earlier, we were not 
using the Knockout feature. Therefore, the bright version of the image was on the 
top, the dark version was on the bottom and we used a vector mask to reveal small 
areas of the bright layer. Now, as we start to combine features, we’re going to start 
with the dark version of the image on the top and the bright version on the bot-
tom. When we use the Knockout setting, it’s only capable of poking a hole through 
that underlying layer contained within the same folder. The dark version is going 
to serve as the base of the image, meaning most of the image will be dark. When 
we poke a hole through it, the light version will be revealed in the areas where we 
specify. This will allow us to selectively add the highlights to the image. 

Now we should have the bright version of the image on bottom and the dark ver-
sion of the image on the top. We need to place the layer containing the dark ver-
sion in a folder, or group, as this will allow us to use the “Knockout Shallow” setting 
later. With the dark layer active, we’ll click the folder icon at the bottom of the Lay-
ers Panel and the layer will be placed inside a folder. (Note that the words “folder” 
and “group” can be used interchangeably.) 
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Next, we need to create that empty adjustment layer so that we can use it to poke 
a hole through the bright layer. We’ll click the Adjustment Layer icon at the bottom 
of the Layers Panel and choose “Brightness/Contrast” from the pop-up menu. Re-
member, you can use any type of adjustment layer that does NOT make automatic 
changes to the image when it is created. We’ll make sure that this adjustment layer 
is positioned right above the dark layer, inside the group. 

ISOLATE AN AREA WITH THE PEN TOOL, APPLIED ON THE VECTOR MASK 

We’re going to use a vector mask to isolate one of the panels on the building. The 
adjustment layer already contains a layer mask. By clicking on the Layer Mask icon 
at the bottom of the Layers Panel, we will be adding a vector mask. Both of the 
masks should be active by default.

We’re now going to use the Pen Tool to isolate one of the panels on the left side 
of the building. Because the Pen Tool is a tool that creates paths, it will be applied 
to the vector mask and not the layer mask. We’ll activate the Pen Tool and click on 
one of the corners on the panel we want to isolate. Then we’ll click on the other 
corners, making straight path lines between them. We’ll click on the point where 
we began to close the path. 

SET ADJUSTMENT LAYER TO KNOCKOUT SHALLOW 

Nothing happened to the image when we created the path and that’s because we 
have not yet changed the Knockout setting of the adjustment layer. With the ad-
justment layer active, we’ll click on the FX icon at the bottom of the Layers Panel 
and choose Blending Options from the pop-up menu. The Layer Style dialog will 
appear and we’ll set the Knockout menu to Shallow. Remember, using the Shal-
low setting will cause the layer to poke a hole through all underlying layers that 
are contained within the same folder. We’ll click OK to exit the Layer Style dialog. 
The panel that we isolated will now be bright because the mask is poking a hole 
through the dark layer to reveal the bright layer below it. 



Extreme Editing Workflow © Ben Willmore, All rights reserved 16

ADD THE GRADIENT TO THE LAYER MASK 

We can now add the gradient to the targeted panel. We’ll activate the Gradient Tool, 
which will automatically apply to the layer mask (not the vector mask) because it 
is the type of tool that affects pixels. We’ll make sure that the gradient menu in the 
Options Bar is set to “Foreground to Background.” We’ll use the tool to click to the 
right of the panel and drag left, to about the middle of the panel, before releasing 
the mouse button. The gradient will be applied to the panel. We’re only seeing the 
gradient in the area where the panel is because it’s being isolated by the path that 
has been applied to the vector mask. 

A gradient was applied to the layer mask. The areas isolated with the layer mask and the  
vector mask are poking a hole through the dark layer to reveal the bright area underneath.
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FEATHER THE PATH EDGE 

In order to make the transition 
between bright and dark layers 
look realistic, we can feather the 
vector mask very slightly. We’ll 
open the Properties Panel and 
make sure that the vector mask 
icon is selected at the top  of the 
panel. This will cause the Feath-
er slider to appear. We’ll set this 
to one pixel, softening the edge 
just enough to look realistic. 

REPEAT THE PROCESS

We have added a highlight to one of the building panels. Now we need to repeat 
the process for the other panels as well as any other areas that we want to high-
light. We will create a new empty adjustment layer for every area we want to isolate 
and highlight. Here is the general process:

1. Create an adjustment layer by clicking the Adjustment Layer icon at the bottom 
of the Layers Panel and choosing an adjustment that won’t initially change the 
image. (Brightness/Contrast, Curves, Levels, etc.)

2. Click the Layer Mask icon to add a vector mask to the adjustment layer. 

3. Click the FX icon to open the Layer Style dialog and set the Knockout menu to 
Shallow. 

4. Use the Pen Tool to isolate the area where you want to add the highlight.

5. Use the Gradient Tool to add the gradient within the area you isolated with the 
path.

The Feather 
setting in the 
Properties 
Panel is being 
used to slightly 
soften the path 
edge.
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6. Feather the path edge by one pixel. This can be done by opening the Properties 
Panel and making sure the mask icon at the top is set to Vector Mask (not Layer 
Mask). Move the Feather slider to 1 px. 

Save Time by Creating a Template Layer (33:31)

As you can probably see, the process of creating these layers and applying all of 
the necessary settings can be very time consuming (especially if there are a lot of 
areas you need to isolate, like we have in the example image). We can save time by 
setting up one layer in the way we need and then duplicating that layer for every 
area we want to highlight. Here are the steps:

1. Create an empty adjustment layer (We use Brightness/Contrast in this lesson.)

2. Click the Layer Mask icon in order to add a vector mask. (The adjustment layer 
will already have a layer mask.) 

3. Fill the layer mask with black by click-
ing on the Edit menu, choosing Fill 
and then setting the Content menu 
to Black. Note that we are filling the 
mask with black because we want to 
selectively choose which areas should 
be visible. It will be easier to do this if 
we start with a black mask that hides 
everything. 

4. Set the Knockout setting to Shallow by 
clicking on the FX icon at the bottom 
of the Layers Panel, choosing Blending 
Options and then setting the Knockout 
menu to Shallow. 

5. Open the Properties Panel, choose the Vector Mask setting and adjust the Feath-
er slider to one pixel. 

The Edit > Fill command is being used to fill 
the layer mask with black.
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Now we have an adjustment layer with all of the settings ready to go. We can now 
duplicate this layer and use the duplicate to isolate and highlight an area. We can 
continue to create duplicates of this template layer for each area we want to work 
on. Note that you can duplicate an active layer either by dragging it to the New 
Layer icon at the bottom of the Layers Panel or by using the keyboard shortcut 
Command+J (Ctrl+J on Win). 

How to Prevent Photoshop from Bombing on You (35:21)

There is currently (as of June of 2020) a bug within Photoshop that will cause it to 
bomb (suddenly quit) if you follow a few specific steps in succession. If you dupli-
cate a layer, then use the Pen Tool on a vector mask, the dot will not be placed on 
the vector mask and the vector mask will suddenly no longer be active. If you click 
on the vector mask to make it active, Photoshop will quit. This is an obscure bug 
that we’ll have to get around. Hopefully Adobe will fix it sometime soon.

Here’s how to avoid having this happen. After duplicating adjustment layer #1 to 
create adjustment layer #2, click back on the original adjustment layer #1 and work 
on it instead. Then, when you need to create another adjustment, click on adjust-
ment layer #2 to make it active. Duplicate this layer to create adjustment layer #3, 
then work on adjustment layer #2. Continue this process. 

NOTE: After duplicating a layer and then returning to the original to work on, make 
sure that both the layer mask and the vector mask are active. Sometimes they will 
not be active after switching layers like this and that will cause problems when you 
try to work on them. 
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Adjusting the Gradients and Brightness (41:10)

After we have worked our way through the image, we will have one layer for each 
panel and for every additional area that we highlighted. If we want to change the 
position of the gradient on any particular area, we can click on the layer to make it 
active (and make sure both masks are active). Then we can use the Move Tool to 
fine-tune the position of the gradient. 

If any of the areas is too bright, we can correct that as well. We would click on the 
layer that contains the too-bright area to make it active. Then we could simply use 
the Opacity setting at the top of the Layers Panel to lower the opacity, therefore 
darkening the layer a bit. 

In the finished image, many empty adjustment layers were used to add highlights to the  
individual areas in the image.
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Use Multiple Layers to Create Sky Gradient (42:26)

Things get a little more complicated in the sky area. In the final effect, the area di-
rectly above the building was brightened slightly. This area is actually water in the 
distance, so I didn’t want to brighten it too much, making it look like sky. The area 
directly above the water was brightened a lot and then the brightening effect fades 
out as you move up the sky. Several layers were used to accomplish this effect. 

A different empty adjustment layer 
was used for each part of the sky. I 
did not add vector masks to these 
individual layers, but each of their 
layer masks was filled with black, 
hiding the bright layer completely. 
Then, I used soft brushes to paint 
on the masks to lighten different 
parts of the sky. I then adjusted the 
opacity of the adjustment layers 
to fine-tune the brightness of each 
area. 

Multiple layers are used to create the effect in the sky. You can see the “before” version on the 
left and the “after” version on the right. 

A different empty adjustment layer was used to 
lighten each area of the sky. The opacity settings 
for these adjustment layers were then changed so 
that each area could be a different brightness. 



Extreme Editing Workflow © Ben Willmore, All rights reserved 22

I DID need a vector mask to limit these adjustments to the sky area, preventing 
overspill onto the building. I selected all of the adjustment layers affecting the sky 
and placed them inside a group by clicking the folder icon at the bottom of the 
Layers Panel. 

Then, I added a vector mask to the group itself and used the Pen Tool to create a 
path around the sky. This limits the effect created by all of the adjustment layers 
inside the group. 

The adjustment layers affecting the sky were 
placed into a group and a vector mask was  
applied to that entire folder. The Pen Tool was 
used to create a path around the sky, as you can 
see above. 
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I also wanted to prevent the sky adjustments from affecting the water area. To do 
this, I used a layer mask attached to the group itself. I used the Brush Tool to paint 
on the mask with black in order to prevent the other layers from affecting the water 
area. The effect was too extreme so I used a Levels adjustment on the layer mask 
to lighten that black paint stroke until the water area looked natural. 

There is another challenge in creating the adjustments for the sky. If I use the 
Knockout Shallow setting on the adjustment layers, it will cause these sky adjust-
ment layers to knock through all the layers contained within the same group. The 
problem is that I need them to knock all the way through the layer containing the 
dark version of the image, which is near the bottom of the layer stack. I can do that 
by additionally changing the Knockout setting for the folder itself. After setting the 
folder itself (as well as all the adjustment layers inside) to Knockout Shallow, it was 
able to knock through two levels of folders and reveal the bright layer at the bot-
tom of the layer stack. The same technique was used to lighten the center, vertical 
element in the image. 

Above, we are viewing the layer mask in the image window. This mask is attached to the 
group of layers affecting the sky. The gray area is where we painted in order to lessen the 
brightening effect on the area where the water is. 
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Convert to Grayscale & Use Lightroom to Tint Layer (53:35)

The original image was a color photograph, which used the RGB mode. Even after I 
used Camera Raw to make the image black and white, the image remained in RGB 
mode. RGB files are made up of three channels: red, green and blue. An image in 
Grayscale mode is just made up of one channel: Gray. This means that an RGB im-
age is three times the size as a grayscale image. 

I like the idea of using the Grayscale mode because of the lower file size. But it can 
also be nice to have the option of toning the image later. You would think that we’d 
need the image to be in RGB in order to do this, BUT that’s not truly the case. We 
can get a little sneaky. 

Before working on the image to create the black and white effect, we’ll follow these 
steps:

To convert the image, we’ll click on the Image menu and choose Mode > Grayscale. 
A dialog will appear, asking if we’d like to rasterize the smart object. We’ll click the 
“Don’t Rasterize” button. 

Next, we’ll click on the Layer menu and choose Smart Objects > New Smart Object 
via Copy. This command will create a duplicate of the smart object that is com-
pletely independent of the original smart object. This means we can make changes 
to the duplicate and the original will remain unchanged. 

We’ll double-click on the thumbnail 
for the duplicate to open it in Cam-
era Raw. Here, we want to make the 
image bright. I saved the settings to 
create the bright version as a Snap-
shot that is included in the file you 
received with the lesson. Click on 
the Snapshots tab and choose the 
“Bright Version.” Click OK to exit 
Camera Raw and return to Photo-
shop’s main interface. In Camera Raw, we are using the Snapshots Panel 

(circled) to choose the “Bright Version” snapshot. 
This is part of the file included with the lesson.
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We will now have two versions of the image: the dark version and the light version. 
This is where we would start the technique, following the steps in this lesson. 

Now let’s say that we want to give the image a slight blue tint. You would think 
that would be impossible because the image is in Grayscale mode. We can use 
Lightroom to get around this. We’ll save the image and then open it in Lightroom. 
In Lightroom, we can use the Split Toning settings to add a tint and it will allow us 
to apply this coloring to an image that is in Grayscale mode. When we export the 
file, it will export in RGB mode even though it is coming from a layered Photoshop 
file that is in grayscale mode. 

After applying the dramatic black and white technique on the grayscale image in Photoshop, 
we opened it in Lightroom and are using the Split Toning settings to apply a tint to the  
image.


